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MSP430FR6989 LaunchPad™ Development Kit
(MSP‑‑EXP430FR6989)

The MSP-EXP430FR6989 LaunchPad™ Development Kit is an easy-to-use evaluation module (EVM) for
the MSP40FR6989 microcontroller (MCU). It contains everything needed to start developing on the ultra-
low-power MSP430FRx FRAM microcontroller platform, including on-board emulation for programming,
debugging, and energy measurements.

Figure 1. MSP-EXP430FR6989 LaunchPad Development Kit

LaunchPad, BoosterPack, EnergyTrace++, EnergyTrace, E2E are trademarks of Texas Instruments.
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1 Getting Started

1.1 Introduction

The MSP-EXP430FR6989 LaunchPad Development Kit is an easy-to-use Evaluation Module (EVM) for
the MSP40FR6989 microcontroller (MCU). It contains everything needed to start developing on the ultra-
low-power MSP430FRx FRAM microcontroller platform, including on-board emulation for programming,
debugging and energy measurements. The board features on-board buttons and LEDs for quick
integration of a simple user interface as well as a Liquid Crystal Display (LCD) display which showcases
the integrated driver that can drive up to 320 segments. It also offers direct access to the Extended Scan
Interface, which is a dual analog front-end (AFE) created for low-power rotation detection. The
MSP430FR6989 device features ultra-low power consumption, 128KB of embedded ferroelectric random
access memory (FRAM), a nonvolatile memory known for its ultra-low power, high endurance, and high-
speed write access.

Rapid prototyping is simplified by the 40-pin BoosterPack™ Plug-in Module headers, which support a wide
range of available BoosterPack modules. You can quickly add features like wireless connectivity, graphical
displays, environmental sensing, and much more. Design your own BoosterPack or choose among many
already available from TI and third party developers.

The out-of-box provided with the MSP-EXP430FR6989 LaunchPad features the on-board segmented
display and offers two operating modes. Stopwatch Mode can run a timer for up to 24 hours, or
alternatively operate split time, where the display can be frozen and the stopwatch continues running in
the background. The second mode provides a simple thermometer application using the on-chip
temperature sensor. The temperature is displayed on the LCD and can be shown in degrees Fahrenheit or
Celsius.

Free software development tools are also available, such as TI's Eclipse-based Code Composer Studio
(CCS) and IAR Embedded Workbench. Both of these IDEs support EnergyTrace++™ technology for real-
time power profiling and debugging when paired with the MSP430FR6989 LaunchPad. More information
about the LaunchPad, the supported BoosterPack modules and available resources can be found at TI's
LaunchPad portal.

1.2 Key Features

• MSP ULP FRAM technology based MSP430FR6989 16-bit MCU

• EnergyTrace++ technology available for ultra-low-power debugging

• 40 pin LaunchPad standard leveraging the BoosterPack ecosystem

• Onboard eZ-FET emulation

• Two buttons and two LEDs for user interaction

• Segmented LCD

• Pins for direct access to the Extended Scan Interface

1.3 What's Included

1.3.1 Kit Contents

• 1x MSP-EXP430FR6989 LaunchPad Development Kit

• 1x Micro USB cable

• 1x Quick Start Guide

1.3.2 Software Examples

• Out-of-Box Software

• Blink LED
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1.4 First Steps: Out-of-Box Experience

An easy way to get familiar with the EVM is by using its preprogrammed out-of-box code. This code
demonstrates some key features from a user level.

1.4.1 Connecting to the Computer

Connect the LaunchPad using the included USB cable to a computer. A green power LED should
illuminate. For proper operation, drivers are needed. TI recommends installing these driver by installing an
IDE such as TI's CCS or IAR EW430. Drivers are also available at http://www.ti.com/MSPdrivers.

1.4.2 Running the Out-of-Box Demo

When connected to your computer, the LaunchPad powers up and displays a greeting message on the
LCD. Press and hold the S1 and S2 buttons simultaneously to select a new mode. See Section 3 for
detailed explanations of each mode.

1.4.2.1 Stopwatch Mode

This mode provides a simple stopwatch application. It supports split time, where the display freezes while
the stopwatch continues running in the background.

Timer Stopped:

S1 : Start time

S2 : Reset time

Timer Running:

S1 : Stop time

S2 : Split time (lap time)

1.4.2.2 Temperature Mode

This mode provides a simple thermometer application. Using the on-chip temperature sensor, the
temperature is displayed on the LCD.

S1 : Pause current temperature

S2 : Toggle temperature between °F and °C

1.5 Next Steps: Looking Into the Provided Code

After the EVM features have been explored, the fun can begin. It's time to open an integrated
development environment and start editing the code examples. Refer to Section 4 for available IDEs and
where to download them.

The quickest way to get started using the LaunchPad is to use TI's Cloud Development Tools,
http://dev.ti.com. The cloud-based Resource Explorer provides access to all of the examples and
resources in MSPWare. Code Composer Studio Cloud is a simple Cloud-based IDE that enables
developing and running applications on the LaunchPad.

The out-of-box source code and more code examples are provided for download at
http://www.ti.com/tool/msp-exp430fr6989. Code is licensed under BSD, and TI encourages reuse and
modifications to fit specific needs.

Section 3 describes all functions in detail and provides a project structure to help familiarize you with the
code.

With the onboard eZ-FET emulator debugging and downloading new code is simple. A USB connection
between the EVM and a PC through the provided USB cable is all that is needed.
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2 Hardware

Figure 2 shows an overview of the MSP-EXP430FR6989 hardware.

Figure 2. MSP-EXP430FR6989 Overview

5SLAU627A–May 2015–Revised July 2015 MSP430FR6989 LaunchPad™ Development Kit (MSP‑EXP430FR6989)
Submit Documentation Feedback

Copyright © 2015, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU627A


Target Device

MSP430FR6989

Crystal

32.768 kHz

Micro‐B

USB

3.3‐V

LDO

ESD

Protection

Debug

MCU

LED

Red or Green

Crystal

4 MHz

UART or SBW to

Target

User Interface

Two Buttons and

Two LEDs

40‐pin LaunchPad

Standard Headers

Power to Target

Reset

Button
Segmented LCD

EnergyTrace

Interface to ESI

Hardware www.ti.com

2.1 Block Diagram

Figure 3 shows the block diagram.

Figure 3. MSP-EXP430FR6989 Block Diagram

2.2 Hardware Features

2.2.1 MSP430FR6989

The MSP430FR6989 is the next device in TI's new ULP FRAM technology platform. FRAM is a cutting
edge memory technology, combining the best features of flash and RAM into one nonvolatile memory.

Device features include:

• 1.8-V to 3.6-V operation

• 16-bit RISC architecture up to 16-MHz system clock and 8-MHz FRAM access

• 128KB of nonvolatile FRAM

• 100 µA/MHz active mode and 350 nA standby with RTC and 3.7-pF crystal

• Certified ULPBench score of 109

• 320-segment LCD controller

• Extended Scan Interface

• 16-channel 12-bit ADC

• Comparator

• Five Timers

• Direct memory access

• 256-bit AES

• 83 GPIOs
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On devices with UART BSL: P2.0: BSLTX; P2.1: BSLRX

On devices with I2C BSL: P1.6: BSLSDA; P1.7: BSLSCL

Figure 4. MSP430FR6989IPZ Pinout
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2.2.2 eZ-FET Onboard Emulator With EnergyTrace™ Technology

To keep development easy and cost effective, TI's LaunchPad Development Kits integrate an onboard
emulator, which eliminates the need for expensive programmers. The MSP-EXP430FR6989 has the eZ-
FET emulator (see Figure 5), which is a simple and low-cost debugger that supports all MSP430 device
derivatives.

Figure 5. eZ-FET Emulator

The MSP-EXP430FR6989 LaunchPad features full EnergyTrace++ technology. The EnergyTrace
functionality varies across the MSP portfolio, shown in Table 1.

Table 1. EnergyTrace Technology

Features EnergyTrace™ Technology EnergyTrace++™ Technology

Current Monitoring Yes Yes

CPU State No Yes

Peripheral and System State No Yes

Devices Supported All MSP430 MCUs MSP430FR59xx and FR69xx MCUs

Development Tool Required MSP-FET or eZ-FET MSP-FET or eZ-FET

The eZ-FET also provides a "backchannel" UART-over-USB connection with the host, which can be very
useful during debugging and for easy communication with a PC. The provided UART supports hardware
flow control (RTS and CTS), although by default these signals are not connected to the target.

In Figure 5, the dotted line through J101 divides the eZ-FET emulator from the target area. The signals
that cross this line can be disconnected by jumpers on J101, the isolation jumper block. More details on
the isolation jumper block are in Section 2.2.3.

The eZ-FET hardware can be found in the schematics in Section 6 and in the MSP-EXP430FR6989
Hardware Design Files. The software and more information about the debugger can be found on the eZ-
FET wiki.
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2.2.3 Emulator Connection: Isolation Jumper Block

The isolation jumper block at jumper J101 connects or disconnects signals that cross from the eZ-FET
domain into the MSP430FR6989 target domain. This includes eZ-FET Spy-Bi-Wire signals, application
UART signals, and 3.3-V and 5-V power (see Table 2 and Figure 6).

Reasons to open these connections:

• To remove any and all influence from the eZ-FET emulator for high accuracy target power
measurements

• To control 3-V and 5-V power flow between the eZ-FET and target domains

• To expose the target MCU pins for other use than onboard debugging and application UART
communication

• To expose the programming and UART interface of the eZ-FET so that it can be used for devices other
than the onboard MCU.

Table 2. Isolation Block Connections

Jumper Description

GND Ground

5V 5-V VBUS from USB

3V3 3.3-V rail, derived from VBUS in the eZ-FET domain

Backchannel UART: Ready-To-Send, for hardware flow control. The target can use this to indicate whether it is
RTS >>

ready to receive data from the host PC. The arrows indicate the direction of the signal.

Backchannel UART: Clear-To-Send, for hardware flow control. The host PC (through the emulator) uses this to
CTS <<

indicate whether it is ready to receive data. The arrows indicate the direction of the signal.

Backchannel UART: The target FR6989 receives data through this signal. The arrows indicate the direction of the
RXD <<

signal.

Backchannel UART: The target FR6989 sends data through this signal. The arrows indicate the direction of the
TXD >>

signal.

SBW RST Spy-Bi-Wire emulation: SBWTDIO data signal. This pin also functions as the RST signal (active low).

SBW TST Spy-Bi-Wire emulation: SBWTCK clock signal. This pin also functions as the TST signal.
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Figure 6. eZ-FET Isolation Jumper Block Diagram

2.2.4 Application (or "Backchannel") UART

The backchannel UART allows communication with the USB host that is not part of the target application's
main functionality. This is very useful during development, and also provides a communication channel to
the PC host side. This can be used to create graphical user interfaces (GUIs) and other programs on the
PC that communicate with the LaunchPad.

Figure 7 shows the pathway of the backchannel UART. The backchannel UART is the UART on
eUSCI_A1. This UART channel is separate from the UART on the 20-pin BoosterPack connector
(eUSCI_A0).

On the host side, a virtual COM port for the application backchannel UART is generated when the
LaunchPad enumerates on the host. You can use any PC application that interfaces with COM ports,
including terminal applications like Hyperterminal or Docklight, to open this port and communicate with the
target application. You need to identify the COM port for the backchannel. On Windows PCs, Device
Manager can assist.
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Figure 7. Application Backchannel UART in Device Manager

The backchannel UART is the "MSP Application UART1" port. In this case, Figure 7 shows COM13, but
this port can vary from one host PC to the next. After you identify the correct COM port, configure it in
your host application according to its documentation. You can then open the port and begin
communication to it from the host.

On the target MSP430FR6989 side, the backchannel is connected to the eUSCI_A1 module. The eZ-FET
has a configurable baud rate; therefore, it is important that the PC application configures the baud rate to
be the same as what is configured on the eUSCI_A1.

The eZ-FET also supports hardware flow control, if desired. Hardware flow control (CTS and RTS
handshaking) allows the target MSP430FR6989 and the emulator to tell each other to wait before sending
more data. At low baud rates and with simple target applications, flow control may not be necessary.
Applications with higher baud rates and more interrupts to service have a higher likelihood that the will not
be able to read the eUSCI_A1 RXBUF register in time, before the next byte arrives. If this happens, the
eUSCI_A1 UCA1STATW register reports an overrun error.

2.2.5 Special Features

2.2.5.1 Liquid Crystal Display (LCD)

The MSP430FR6989 LaunchPad features an on-board LCD! This LCD is driven by the internal LCD driver
on the MSP430FR6989 device.

There are many available LCD segments, including six full alpha-numeric numbers or letters in addition to
several symbols at the top for various modes or applications. Figure 8 shows the layout of the LCD, and
Table 3 and Table 4 list the mapping of these segments.

Figure 8. LCD Segment Layout
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Table 3. LCD FH-1138P Segment Mapping

PIN COM3 COM2 COM1 COM0

1 A1E A1F A1G A1M

2 A1A A1B A1C A1D

3 A1Q NEG A1N A1DP

4 A1H A1J A1K A1P

5 A2E A2F A2G A2M

6 A2A A2B A2C A2D

7 A2Q A2COL A2N A2DP

8 A2H A2J A2K A2P

9 A3R A3F A3G A3M

10 A3A A3B A3C A3D

11 A3Q ANT A3N A3DP

12 A3H A3J A3K A3P

13 A4R A4F A4G A4M

14 A4A A4B A4C A4D

15 A4Q A4COL A4N A4DP

16 A4H A4J A4K A4P

17 A5E A5F A5G A5M

18 A5A A5B A5C A5D

19 A5Q DEG A5N A5DP

20 A5H A5J A5K A5P

21 COM3 - - -

22 - COM2 - -

23 - - COM1 -

24 - - - COM0

25 - - - -

26 - - - -

27 - - - -

28 - - - -

29 - - - -

30 - - - -

31 - - - -

32 TMR HRT REC !

33 B6 B4 B2 BATT

34 B5 B3 B1 []

35 A6E A6F A6G A6M

36 A6A A6B A6C A6D

37 A6Q TX A6N RX

38 A6H A6J A6K A6P
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Table 4. LCD-to-MSP Connections
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LCDM22 P2.4 S43 P2.5 S42

LCDM21 P2.6 S41 P2.7 S40

LCDM20 P10.2 S39 16 A4H A4J A4K A4P P5.0 S38 15 A4Q A4COL A4N A4DP

LCDM19 P5.1 S37 14 A4A A4B A4C A4D P5.2 S36 13 A4R A4F A4G A4M

LCDM18 P5.3 S35 34 B5 B3 B1 [] P3.0 S34

LCDM17 P3.1 S33 P3.2 S32

LCDM16 P6.7 S31 20 A5H A5J A5K A5P P7.5 S30 19 A5Q DEG A5N A5DP

LCDM15 P7.6 S29 18 A5A A5B A5C A5D P10.1 S28 17 A5E A5F A5G A5M

LCDM14 P7.7 S27 33 B6 B4 B2 BATT P3.3 S26

LCDM13 P3.4 S25 P3.5 S24

LCDM12 P3.6 S23 P3.7 S22

LCDM11 P8.0 S21 4 A1H A1J A1K A1P P8.1 S20 3 A1Q NEG A1N A1DP

LCDM10 P8.2 S19 2 A1A A1B A1C A1D P8.3 S18 1 A1E A1F A1G A1M

LCDM9 P7.0 S17 38 A6H A6J A6K A6P P7.1 S16 37 A6Q TX A6N RX

LCDM8 P7.2 S15 36 A6A A6B A6C A6D P7.3 S14 35 A6E A6F A6G A6M

LCDM7 P7.4 S13 8 A2H A2J A2K A2P P5.4 S12 7 A2Q A2COL A2N A2DP

LCDM6 P5.5 S11 6 A2A A2B A2C A2D P5.6 S10 5 A2E A2F A2G A2M

LCDM5 P5.7 S9 12 A3H A3J A3K A3P P4.4 S8 11 A3Q ANT A3N A3DP

LCDM4 P4.5 S7 10 A3A A3B A3C A3D P4.6 S6 9 A3R A3F A3G A3M

LCDM3 P4.7 S5 P10.0 S4 32 TMR HRT REC !

LCDM2 P4.0 S3 P4.1 S2

LCDM1 P1.4 S1 P1.5 S0

2.2.5.2 Extended Scan Interface (ESI)

The MSP430FR6989 LaunchPad features pins to access the extended scan interface on the device.
These pins are accessed on the through connector ESI1. Some of these pins are also connected to the
BoosterPack header pins. For applications that use the ESI and a connected BoosterPack, be sure to
check for any pin conflicts. Pins can be disconnected from the ESI header using the 0-Ω resistors R6 to
R12, R14, and R15.

The ESI1 header matches the ESI access header on EVM430-FR6989. This EVM is built to show off the
ESI functionality more thoroughly. Any plugin modules from the EVM430-FR6989 can be reused on the
MSP-EXP430FR6989 LaunchPad. Note that when populating the ESI1 header, it must be plugged in from
the bottom side to match the EVM430-FR6989.
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2.3 Power

The board was designed to accommodate various powering methods, including through the on-board eZ-
FET as well as external or BoosterPack power.

Figure 9. MSP-EXP430FR6989 Power Block Diagram

2.3.1 eZ-FET USB Power

The most common power-supply scenario is from USB through the eZ-FET debugger. This provides 5-V
power from the USB and also regulates this power rail to 3.3 V for eZ-FET operation and 3.3 V to the
target side of the LaunchPad. Power from the eZ-FET is controlled by jumper J101. For 3.3 V, make sure
that a jumper is connected across the J101 3V3 terminal.

2.3.2 BoosterPack and External Power Supply

Header J6 is present on the board to supply external power directly. It is important to comply with the
device voltage operation specifications when supplying external power. The MSP430FR6989 has an
operating range of 1.8 V to 3.6 V. More information can be found in the MSP430FR6989 device data
sheet.
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2.4 Measure MSP430 Current Draw

To measure the current draw of the MSP430FR6989 using a multi-meter, use the 3V3 jumper on the
jumper isolation block. The current measured includes the target device and any current drawn through
the BoosterPack headers.

To measure ultra-low power, follow these steps:

1. Remove the 3V3 jumper in the isolation block, and attach an ammeter across this jumper.

2. Consider the effect that the backchannel UART and any circuitry attached to the MSP430FR6989 may
have on current draw. Consider disconnecting these at the isolation jumper block, or at least consider
their current sinking and sourcing capability in the final measurement.

3. Make sure there are no floating inputs/outputs (I/Os). These cause unnecessary extra current draw.
Every I/O should either be driven out or, if it is an input, should be pulled or driven to a high or low
level.

4. Begin target execution.

5. Measure the current. Keep in mind that if the current levels are fluctuating, it may be difficult to get a
stable measurement. It is easier to measure quiescent states.

Alternatively, EnergyTrace++ technology can be used to measure the same current, and see energy
profiles through integrated GUI in CCS and IAR. EnergyTrace allows you to compare various current
profiles and better optimize your energy performance!

2.5 Clocking

The MSP-EXP430FR6989 provides an external clock in addition to the internal clocks in the device.

• Y1: 32-kHz MicroCrystal crystal (MS3V)

The 32-kHz crystal allows for lower LPM3 sleep currents than do the other low-frequency clock sources.
Therefore, the presence of the crystal allows the full range of low-power modes to be used.

The internal clocks in the device default to the following configuration:

• MCLK: DCO 1 MHz

• SMCLK: DCO 1 MHz

• ACLK: REFO 32.768 kHz

For more information about configuring internal clocks and using the external oscillators, see the
MSP430FR69xx Family User's Guide.

2.6 Using the eZ-FET Emulator with a Different Target

The eZ-FET emulator on the LaunchPad can interface to most MSP430 derivative devices, not just the on-
board MSP430FR6989 target device.

To do this, disconnect every jumper in the isolation jumper block. This is necessary, because the emulator
cannot connect to more than one target at a time over the Spy-Bi-Wire (SBW) connection.

Next, make sure the target board has proper connections for SBW. Note that to be compatible with SBW,
the capacitor on RST/SBWTDIO cannot be greater than 2.2 nF. The documentation for designing MSP430
JTAG interface circuitry is the MSP430 Hardware Tools User's Guide.

Finally, wire together these signals from the emulator side of the isolation jumper block to the target
hardware:

• 5 V (if 5 V is needed)

• 3.3 V

• GND

• SBWTDIO

• SBWTCK

• TXD (if the UART backchannel is to be used)

• RXD (if the UART backchannel is to be used)
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• CTS (if hardware flow control is to be used)

• RTS (if hardware flow control is to be used)

This wiring can be done either with jumper wires or by designing the board with a connector that plugs into
the isolation jumper block.

2.7 BoosterPack Pinout

The LaunchPad adheres to the 40-pin LaunchPad pinout standard. A standard was created to aid
compatibility between LaunchPad and BoosterPack tools across the TI ecosystem.

The 40-pin standard is compatible with the 20-pin standard that is used by other LaunchPad kits like the
MSP-EXP430FR4133. This allows some subset of functionality of 40-pin BoosterPack modules to be used
with 20-pin LaunchPad kits.

While most BoosterPack modules are compliant with the standard, some are not. The MSP-
EXP430FR6989 LaunchPad is compatible with all 40-pin BoosterPack modules that are compliant with the
standard. If the reseller or owner of the BoosterPack does not explicitly indicate compatibility with the
MSP-EXP430FR6989 LaunchPad, compare the schematic of the candidate BoosterPack with the
LaunchPad to ensure compatibility. Keep in mind that sometimes conflicts can be resolved by changing
the MSP430FR6989 device pin function configuration in software. More information about compatibility
can also be found at http://www.ti.com/launchpad.

Figure 10 shows the 40-pin pinout of the MSP430FR6989 LaunchPad.

Note that software configuration of the pin functions plays a role in compatibility. The LaunchPad side of
the dashed line in Figure 10 shows all of the functions for which the MSP430FR6989 device pins can be
configured. This can also be seen in the MSP430FR6989 data sheet. The BoosterPack side of the dashed
line shows the standard. The LaunchPad function whose color matches the BoosterPack function shows
the specific software-configurable function by which the MSP430FR6989 LaunchPad adheres to the
standard.
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Figure 10. LaunchPad to BoosterPack Connector Pinout
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2.8 Design Files

2.8.1 Hardware

Schematics can be found in Section 6. All design files including schematics, layout, bill of materials
(BOM), Gerber files, and documentation are available in the MSP-EXP430FR6989 Hardware Design Files.

2.8.2 Software

All design files including TI-TXT object-code firmware images, software example projects, and
documentation are available in the MSP-EXP430FR6989 Software Examples.

2.9 Hardware Change log

Table 5. Hardware Change Log

PCB Revision Description

Rev 1.0 Initial Release

3 Software Examples

There are two software examples included with the MSP430FR6989 LaunchPad (see Table 6), which can
be found in the MSP-EXP430FR6989 Software Examples and are also available in MSP430Ware.

Table 6. Software Examples

BoosterPack
Demo Name Description More Details

Required

The out-of-box demo pre-programmed on the LaunchPad from
OutOfBox_FR6989 None Section 3.1

the factory. Demonstrates features of MSP430FR6989 device.

BlinkLED_FR6989 None Blinks an LED on the LaunchPad at a fixed interval. Section 3.2

To use any of the software examples with the LaunchPad, you must have an integrated development
environment (IDE) that supports the MSP430FR6989 device.

Table 7. IDE Minimum Requirements for MSP-EXP430FR6989

Code Composer Studio™ IDE IAR Embedded Workbench® IDE

CCS v6.1 or later IAR Embedded Workbench for Texas Instruments 430 6.10 or later

For more details on how to get started quickly, and where to download the latest CCS and IAR IDEs, see
Section 4.

3.1 Out-of-Box Software Example

This section describes the functionality and structure of the out-of-box software that is preloaded on the
EVM.

There are two modes in the out-of-box software, stopwatch mode and temperature sensor mode, which
can be controlled with S1 and S2 push buttons on the LaunchPad. This demo shows how to utilize the
LCD_C module, combined with the RTC counter, ADC, and internal temperature sensor, to implement
simple stopwatch and thermometer.
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3.1.1 Source File Structure

The project is split into multiple files. This makes it easier to navigate and reuse parts of it for other
projects (see Table 8).

Table 8. Source File and Folders

Name Description

main.c The out-of-box demo main function, initializations, shared ISRs, and other functions

hal_LCD.c Hardware abstraction layer for LCD

StopWatchMode.c Main function file for stopwatch mode

TempSensorMode.c Main function file for live thermometer mode

Library: Driverlib Device driver library (http://www.ti.com/tool/msp430driverlib)

3.1.2 Power-up and Idle

Upon powering up the out-of-box demo, the LCD displays a scrolling welcome message. The
MSP430FR6989 then enters a loop, in which the LCD cycles through all of its segments followed by a
scrolling instruction message to "Hold S1 and S2 to switch modes".

3.1.3 Stopwatch Mode

While in the power up and idle state or in the temperature sensor mode, the stopwatch mode can be
entered by holding down both S1 and S2 buttons shortly. The LCD displays scrolling text "STOPWATCH
MODE" to indicate successful entry into this mode.

The MSP430FR6989 initializes the stopwatch calendar to HH:MM:SS:CC = 00:00:00:00, then goes to
sleep in LPM3. Because the onboard LCD has six alphanumeric digits, the stopwatch format is initially
MM:SS:CC, but will become HH:MM:SS when the timer reaches the first hour. This stopwatch counts up
to 23h59m59s before resetting back to 00h00m00s.

By pressing the S1 button, the user can start the stopwatch timer (counts up). While the timer is running,
the MSP430FR6989 sleeps and wakes between LPM3 (waiting for RTC interrupt) and active mode
(incrementing calendar and updating LCD). Pressing the S1 button again will stop the stopwatch timer and
returns the MSP430FR6989 back to LPM3 to conserve power. When the stopwatch timer is stopped,
pressing S2 button will reset the timer back to 00:00:00.

While the stopwatch timer is running, pressing S2 button pauses the LCD at the current time but keeps
the timer running in the background, allowing for the "Split timer" functionality. LCD can be resumed to the
running timer by pressing S2 button again.

3.1.4 Temperature Sensor Mode

While inside the stopwatch mode, the temperature sensor mode can be entered by holding down both S1
and S2 buttons shortly. The LCD displays scrolling text "TEMPSENSOR MODE" to indicate successful
entry into this mode.

Upon entering this mode, the MSP430FR6989 initializes the ADC input to its internal temperature sensor
and starts sampling and conversion at four times per second. Each time an ADC conversion completes,
the LCD shows the calculated temperature to the tenths decimal place.

The temperature unit can be toggled between Celsius and Fahrenheit by pressing the S2 button.

The temperature measurement can also be paused or resumed by pressing the S1 button. While the
temperature measurement is running, the MSP430FR6989 sleeps and wakes between LPM3 (waiting for
ADC sample and conversion to finish) and active mode (processing the results and updating LCD). When
the temperature measurement is paused, the MSP430FR6989 enters LPM3 with the LCD remaining on,
displaying the last measured temperature.
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3.2 Blink LED Example

This very simple software example shows how to software toggle a GPIO to blink an LED on the
LaunchPad.

3.2.1 Source File Structure

The project is split into multiple files. This makes it easier to navigate and reuse parts of it for other
projects (see Table 9).

Table 9. Source File and Folders

Name Description

main.c The Blink LED main function

Library: Driverlib Device driver library (http://www.ti.com/tool/msp430driverlib)

The main code utilizes the MSP430 Driver Library to halt the watchdog timer and to configure or toggle
the GPIO pin connected to the LED inside a software loop.

4 Resources

4.1 Integrated Development Environments

Although the source files can be viewed with any text editor, more can be done with the projects if they
are opened with a development environment like Code Composer Studio™ (CCS), IAR Embedded
Workbench®, or Energia.

4.1.1 TI Cloud Development Tools

TI's Cloud-based software development tools provide instant access to MSPWare content and a web-
based IDE.

4.1.1.1 TI Resource Explorer Cloud

TI Resource Explorer Cloud provides a web interface for browsing examples, libraries and documentation
found in MSPWare without having to download files to your local drive (see Figure 11).

Go check out TI Resource Explorer Cloud now at http://dev.ti.com.
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Figure 11. TI Resource Explorer Cloud

4.1.1.2 Code Composer Studio Cloud

Code Composer Studio Cloud is a web-based IDE that allows code edit, compile and download to devices
right from your web browser. It also integrates seamlessly with TI Resource Explorer Cloud with the ability
to import projects directly on the cloud (see Figure 12).

Go check out Code Composer Studio Cloud now at http://dev.ti.com. A full comparison between CCS
Cloud and CCS Desktop is available at this website.
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Figure 12. CCS Cloud

4.1.2 Code Composer Studio

Code Composer Studio Desktop is a professional integrated development environment that supports TI's
Microcontroller and Embedded Processors portfolio. Code Composer Studio comprises a suite of tools
used to develop and debug embedded applications. It includes an optimizing C/C++ compiler, source code
editor, project build environment, debugger, profiler, and many other features.

You can learn more about CCS and download it at http://www.ti.com/tool/ccstudio.

CCS v6.1 or higher is required. When CCS has been launched, and a workspace directory chosen, use
Project>Import Existing CCS Eclipse Project. Direct it to the desired demo project directory that contains
main.c (see Figure 13).

22 MSP430FR6989 LaunchPad™ Development Kit (MSP‑EXP430FR6989) SLAU627A–May 2015–Revised July 2015
Submit Documentation Feedback

Copyright © 2015, Texas Instruments Incorporated

http://www.ti.com
http://www.ti.com/tool/ccstudio
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU627A


www.ti.com Resources

Figure 13. Directing the Project>Import Function to the Demo Project

Selecting the \CCS subdirectory also works. The CCS-specific files are located there.

When you click OK, CCS should recognize the project and allow you to import it. The indication that CCS
has found it is that the project appears in the box shown in Figure 14, and it has a checkmark to the left of
it.
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Figure 14. When CCS Has Found the Project

Sometimes CCS finds the project but does not show a checkmark; this might mean that your workspace
already has a project by that name. You can resolve this by renaming or deleting that project. (Even if you
do not see it in the CCS workspace, be sure to check the workspace directory on the file system.)

4.1.3 IAR Embedded Workbench for Texas Instruments 430

IAR Embedded Workbench for ARM is another very powerful integrated development environment that
allows you to develop and manage complete embedded application projects. It integrates the IAR C/C++
Compiler, IAR Assembler, IAR ILINK Linker, editor, project manager, command line build utility, and IAR
C-SPY® Debugger.

You can learn more about IAR Embedded Workbench and download it at https://www.iar.com/iar-
embedded-workbench/arm.

IAR 6.10 or higher is required. To open the demo in IAR, click File>Open>Workspace…, and browse to
the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is
contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project>Add-Existing-Project….

Although the software examples have all of the code required to run them, IAR users may download and
install MSP430Ware, which contains MSP430 libraries and the TI Resource Explorer. These are already
included in a CCS installation (unless the user selected otherwise).
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4.1.4 Energia

Energia is a simple, open-source, and community-driven code editor that is based on the Wiring and
Arduino framework. Energia provides unmatched ease of use through very high level APIs that can be
used across hardware platforms. Energia is a light-weight IDE that does not have the full feature set of
CCS or IAR. However, Energia is great for anyone who wants to get started very quickly or who does not
have significant coding experience.

You can learn more about Energia and download it at http://www.energia.nu.

4.2 LaunchPad Websites

More information about the LaunchPad kits, supported BoosterPack modules, and available resources can
be found at:

• MSP-EXP430FR6989 tool folder: resources specific to this particular LaunchPad

• TI's LaunchPad portal: information about all LaunchPad kits from TI

4.3 MSPWare and TI Resource Explorer

TI Resource Explorer is a tool integrated into CCS that allows you to browse through available design
resources. TI Resource Explorer will help you quickly find what you need inside packages including
MSPWare, ControlSuite, TivaWare and more. TI Resource Explorer is well organized to find everything
that you need quickly, and you can import software projects into your workspace in one click!

TI Resource Explorer Cloud is one of the TI Cloud Development tools, and is tightly integrated with CCS
Cloud. See Section 4.1.1 for more information.

MSPWare is a collection of code examples, software libraries, data sheets and other design resources for
ALL MSP devices delivered in a convenient package – essentially everything developers need to become
MSP experts!

In addition to providing a complete collection of existing MSP design resources, MSPWare also includes a
high level API called MSP Driver Library. This library makes it easy to talk to MSP hardware. More
information can be found at http://www.ti.com/tool/mspware.
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Figure 15. Using TI Resource Explorer to Browse MSP-EXP430FR6989 in MSPWare

Inside TI Resource Explorer, these examples and many more can be found, and easily imported into CCS
with one click.

4.4 FRAM Utilities

The TI FRAM Utilities is a collection of embedded software utilities that leverage the ultra-low-power and
virtually unlimited write endurance of FRAM. The utilities are available for MSP430FRxx FRAM
microcontrollers and provide example code to help start application development.

4.4.1 Compute Through Power Loss

Compute Through Power Loss is a utility API set that enables ease of use with LPMx.5 low-power modes
and a powerful shutdown mode that allows an application to save and restore critical system components
when a power loss is detected.
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4.5 MSP430FR6989

4.5.1 Device Documentation

At some point, you will probably want more information about the MSP430FR6989 device. For every MSP
device, the documentation is organized as shown in Table 10.

Table 10. How MSP Device Documentation is Organized

Document For MSP430FR6989 Description

MSP430FR58xx, MSP430FR59xx, Architectural information about the device,
Device family

MSP430FR68xx, and MSP430FR69xx Family including all modules and peripherals such as
user's guide

User's Guide clocks, timers, ADC, and so on.

Device-specific MSP430FR698x(1), MSP430FR598x(1) Mixed- Device-specific information and all parametric
data sheet Signal Microcontrollers data sheet information for this device

4.5.2 MSP430FR6989 Code Examples

MSP430FR5x8x, MSP430FR692x, MSP430FR6x7x, MSP430FR6x8x Code Examples is a set of very
simple C examples that demonstrate how to use the entire set of MSP430 peripherals (including, serial
communication, ADC12, LCD_C, Timer_A, Timer_B, and others) through direct register access.

Every MSP derivative has a set of these code examples. When starting a new project or adding a new
peripheral, these examples serve as a great starting point.

4.5.3 MSP430 Application Notes and TI Designs

There are many application notes that can be found at http://www.ti.com/msp430, in addition to TI Designs
with practical design examples and topics.

4.6 Community Resources

4.6.1 TI E2E™ Community

Search the forums at e2e.ti.com. If you cannot find your answer, post your question to the community!

4.6.2 Community at Large

Many online communities focus on the LaunchPad – for example, http://www.43oh.com. You can find
additional tools, resources, and support from these communities.
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5 FAQs

Q: I can't get the backchannel UART to connect. What's wrong?

A: Check the following:

• Do the baud rate in the host terminal application and the eUSCI settings match?

• Are the appropriate jumpers in place on the isolation jumper block?

• Probe on RXD and send data from the host. If you don't see data, it might be a problem on the host
side.

• Probe on TXD while sending data from the MSP. If you don't see data, it might be a configuration
problem with the eUSCI module.

• Consider the use of the hardware flow control lines (especially for higher baud rates).

Q: Is this the same LCD as the MSP430FR4133 LaunchPad?

A: Yes, this is the exact same LCD. However, there are two differences: the physical pin connections to
the LCD and the LCD module in the MSP devices themselves. The MSP430FR4133 device has the
LCD_E module, while the MSP430FR6989 has the LCD_C module. See the application note Designing
with MSP430 MCUs and Segment LCDs for more information on the differences between the LCD
modules.

Q: Can I purchase the ESI plug-in boards separately from TI?

A: These plug-in boards only come with the EVM430-FR6989 EVM, however, all design files are made
available for you to create your own. See the associated TI Design TIDM-LC-WATERMTR for hardware
design resources and Gerber files.

Q: The MSP G2 LaunchPad had a socket, allowing me change the target device. Why doesn't this
LaunchPad use one?

A: This LaunchPad provides more functionality, and this means using a device with more pins. Sockets for
devices with this many pins are too expensive for the LaunchPad target price.
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6 Schematics

Figure 16. Schematics (1 of 6)
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Figure 17. Schematics (2 of 6)
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Figure 18. Schematics (3 of 6)

31SLAU627A–May 2015–Revised July 2015 MSP430FR6989 LaunchPad™ Development Kit (MSP‑EXP430FR6989)
Submit Documentation Feedback

Copyright © 2015, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU627A


A

B

C

D

1 2 3 4 5 6

A

B

C

D

1 2 3 4 5 6

1

2

3

4

5

6

7 10

11

12

13

14

15

16

8 9

TP

NO1
1

IN1
3

NO2
5

IN2
7

COM1
8

COM2
4

V
+

2
G

N
D

6

Schematics www.ti.com

Figure 19. Schematics (4 of 6)
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Figure 20. Schematics (5 of 6)

33SLAU627A–May 2015–Revised July 2015 MSP430FR6989 LaunchPad™ Development Kit (MSP‑EXP430FR6989)
Submit Documentation Feedback

Copyright © 2015, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU627A


A

B

C

D

1 2 3 4 5 6

A

B

C

D

1 2 3 4 5 6

IO1
1

IO2
2

GND
3

IO3
4

IO4
5

VCC
6

1

1

1

1

1

1

1

1

1

1

2

3

4

5

S
S1*6

IN
1

EN
6

OUT
3

G
N

D
2

Schematics www.ti.com

Figure 21. Schematics (6 of 6)
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STANDARD TERMS FOR EVALUATION MODULES

1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or
documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.

1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility
evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:

2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License
Agreement.

2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM
to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

WARNING

Evaluation Kits are intended solely for use by technically qualified,
professional electronics experts who are familiar with the dangers

and application risks associated with handling electrical mechanical
components, systems, and subsystems.

User shall operate the Evaluation Kit within TI’s recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up

and/or operate the Evaluation Kit within TI’s recommended
guidelines may result in personal injury or death or property
damage. Proper set up entails following TI’s instructions for

electrical ratings of interface circuits such as input, output and
electrical loads.

NOTE:

EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION
KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
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3 Regulatory Notices:

3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:

FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada

3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:

This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

http://www.ti.com


www.ti.com

3

Concernant les EVMs avec antennes détachables

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan

3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に
輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal
Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union

3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

http://www.ti.com
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
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4 EVM Use Restrictions and Warnings:

4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT
LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling
or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:

4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user
guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6. Disclaimers:

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT
LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

http://www.ti.com
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8. Limitations on Damages and Liability:

8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,
INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated
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IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you
permission to use these resources only for development of an application that uses the TI products described in the resource. Other
reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third
party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims,
damages, costs, losses, and liabilities arising out of your use of these resources.

TI’s products are provided subject to TI’s Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on
ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable
warranties or warranty disclaimers for TI products.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated

http://www.ti.com/legal/termsofsale.html
http://www.ti.com
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